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INTRODUCTION

Welcome to What's New in Mastercam 2023! Mastercam 2023 features new functionality focused on delivering 
speed and efficiency to your machining jobs.

Release Highlights
Only have a few minutes? Listed below are a few of the highlights from this release:

 l "Detecting Undercut Stock When Machining" on page 15

 l "Consolidating Multiaxis Toolpaths " on page 27

 l "New B-Axis Contour Turning Toolpath" on page 35

 l "Check Mesh Enhancements" on page 57

 l "Appending Operations to a Current Mastercam Simulator Session " on page 83

 l "Adding Stock Awareness to Holder Checking" on page 24

 l "New Workflow and Interface for Managing Your Machine Groups " on page 103

 l "Creating Consistent Flowlines with Surface Ruled/Lofted" on page 72

 l "Creating Chamfers with Push-Pull  " on page 71

 Mastercam Resources
Enhance your Mastercam 2023 experience by using the following resources:

 l Mastercam Documentation—Mastercam installs  a number of helpful documents  for your version of software in 
the Documentation folder of your Mastercam installation.

 l Mastercam Help—Access Mastercam Help by selecting Help, Contents from Mastercam's File tab or by 
pressing [Alt+H] on your keyboard.

 l Mastercam Reseller—Your local  Mastercam Reseller can help with most questions about Mastercam. 

 l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is open 
Monday through Friday from 8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

 l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic 
Mastercam features and functions. Visit our website, or select Help, Tutorials from Mastercam's File tab to 
see the latest publications.

 l Mastercam University—Mastercam University, an affordable online learning platform, gives you 24/7 access to 
Mastercam training materials. Take advantage of our many videos to master skills at your own pace and help 
prepare for Mastercam Certification. For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit university.mastercam.com/, or email training@mastercam.com. 

 l Online Communities—You can find a wealth of information at www.mastercam.com.

 l Follow us on Facebook (www.facebook.com/Mastercam), Twitter (twitter.com/Mastercam), and 
Instagram (https://www.instagram.com/mastercam/) for the latest tech tips and Mastercam news. 

What's New in Mastercam 2023—Introduction
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 l See Mastercam in action on YouTube (www.youtube.com/user/MastercamCadCam). 

 l For more information on CNC Software, LLC, to find and apply to jobs, and connect with people using 
Mastercam, visit us on LinkedIn (www.linkedin.com/company/cnc-software/). 

 l Registered users can search for information or ask questions on the Mastercam Web forum, 
forum.mastercam.com, or use the Mastercam Knowledge Base at kb.mastercam.com. 

Contact Us
For questions about this or other Mastercam documentation, contact the Technical Documentation Department by 
email at techdocs@mastercam.com. 

What's New in Mastercam 2023—Introduction
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MILLING ENHANCEMENTS

Listed below are major enhancements to the Mill product.  These include improvements to 2D, 3D, and Multiaxis 
toolpaths. 

NOTE
Unless otherwise stated, the new features and functionality listed in this section apply to both Mill and 
Router licenses.

New Behavior for the Apply Button in Milling Toolpaths
The Apply button for tree-style milling toolpaths has been modified to be similar to the OK button. When you click 
Apply, Mastercam processes and applies your toolpath changes without closing the dialog box. If Generate 
toolpath is selected, your changes are applied to the toolpath and the toolpath is automatically regenerated. If 
Generate toolpath is deselected, your toolpath is marked as dirty in the Toolpaths Manager to regenerate at a 
later time. 

Due to this change, the Preview button is no longer necessary and has been removed from the affected toolpaths.

What's New in Mastercam 2023—Milling Enhancements



Re-designed Tool Pages and Tabs for Milling Toolpaths
The Tool page and Toolpath parameters tab for milling toolpaths have been redesigned to provide a better, user-
friendly layout. 

What's New in Mastercam 2023—Milling Enhancements
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New Mill Tool Icons
The new Mill tool icons better express tool functionality and contribute to a more realistic tooling experience in 
Mastercam 2023.  You can view these icons while working in the Tool List Filter dialog box, the Tool Wizard, or the 
stand-alone Tool Manager. 

Overall Process Improvements 
Listed below are general improvements made to Mill toolpaths and processing times. 

 l Equal Scallop’s processing time has improved when making changes to existing operations.

 l General improvements have been made to the linking steps for 3D high speed toolpaths, improving 
processing time and quality of motion.

What's New in Mastercam 2023—Milling Enhancements
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3D Toolpath Enhancements
Listed below are enhancements to 3D milling toolpaths. 

Detecting Undercut Stock When Machining
The Dynamic OptiRough and Area Roughing toolpaths can now be aware of undercut stock conditions resulting in 
improvement to the  toolpath motion including less air cutting. 

Stock Model Detect Undercut Stock Disabled Detect Undercut Stock Enabled

This new Detect undercut stock option is located on the Stock page and is only available when Previous 
operations is set to One other operation. 

What's New in Mastercam 2023—Milling Enhancements



Identifying and Machining Material in Corners
The Equal Scallop toolpath now identifies material left in corners and will machine it with a single pass or with 
multiple passes to ease into the material. The new Step in option allows you to control the removal of material by 
the step ins you define. Distance specifies the amount of material to remove with each step in. Maximum step ins 
specifies the maximum number of step ins. The actual number of step ins performed might be less than the 
maximum specified here.

The Step in options are for semi-finishing applications and not intended for finishing. If Mastercam does not detect 
enough stock to engage, then no more passes are created. Mastercam leaves small amounts of stock so that small 
segments of motion are not created. 

Creating Automatic Boundaries for Toolpath Containment
A new option, Automatic boundary, has been added to the Toolpath Control page for 3D high speed toolpaths. 
This new option allows Mastercam to create a boundary around the selected Machining geometry and uses it as a 
containment boundary in addition to any selected Boundary chains. The new Include stock option adds the stock 
settings from the Stock page to the selected Automatic boundary. You can select from the following options: 

 l None—No boundary is created. The Include stock option is automatically applied.

 l Silhouette—Creates a boundary that is a silhouette of the selected Machining geometry and Boundary 
chains.

 l Bounding rectangle—Creates a rectangle as a boundary.

 l Bounding circle—Creates a circle as a boundary.

What's New in Mastercam 2023—Milling Enhancements
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Due to these changes, the Silhouette boundary option has been removed and added to the Automatic boundary 
drop-down as Silhouette. 

Machining with Zigzag Motion
The Cut Method drop-down on the Cut Parameters page for Area Roughing toolpaths has been replaced with the 
Closed contour direction and Open contour direction drop-downs. These new drop-downs allow you create 
more efficient cutting motion and include reduced retracts on open contours. 

Area Roughing also includes a new Open contour direction option, Zigzag. Zigzag cuts each pass in the opposite 
direction to the previous pass. A short linking motion connects the two ends. 

What's New in Mastercam 2023—Milling Enhancements



One Way Zigzag

What's New in Mastercam 2023—Milling Enhancements
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More Powerful and Flexible 3D Roughing Linking
Mastercam 2022 introduced the new Linking Parameters page for finishing 3D high speed toolpaths, which 
includes new and improved functionality. Mastercam 2023 has expanded this effort to the Dynamic OptiRough, 
Area Roughing, and Horizontal Area toolpaths. 
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Preventing the Tool from Retracting Between Passes

You now control the moves between Z depths using the new Keep tool down between Z depths option. In 
previous releases, Mastercam always retracted to move from Z depth to Z depth on open passes. You can now 
create smooth linking moves between Z depths, with an optional feed rate control. You can also specify a separate 
Feed rate for these moves. Additionally, the Keep tool down option has been moved from the Cut Parameters 
page. 

Keep tool down off Keep tool down on

What's New in Mastercam 2023—Milling Enhancements
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Trimming Passes to Fit Transition Moves

Dynamic OptiRough, Area Roughing, and Horizontal Area now have the ability to trim passes to safely fit the 
transition moves, using the Fit transitions option. This option was previously only available to 3D high speed 
finishing toolpaths. 

Fit transitions off Fit transitions on 

Rest Roughing Against Stock Model Improvements 
When rest machining against one other operation that references a stock model for Dynamic OptiRough and Area 
Roughing toolpaths, the following improvements have been made:  

 l Machining geometry is no longer required. Mastercam now ensures that the stock model can be reached 
from all sides in the machining XY plane when no machining geometry has been defined. 

 l A minimum Z depth set above the stock model is no longer required. Mastercam now ensures all stock is 
machined in the Z direction when no Z depth limits are defined. 

 l Mastercam takes a stepdown at the defined maximum Z depth when set below the stock model to aid in 
breakthrough. 

 l If collision checking is selected on the Holder page, Mastercam is now aware of all stock material that resides 
outside the Z depth limits and/or selected Containment boundaries. 

Set Z depth options on the Steep/Shallow page and Containment boundaries on the Toolpath Control page. 
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Automatically Detecting and Including Stock for Z Depths
The Steep/Shallow page for 3D high speed toolpaths now includes two new options, Automatically detect depth 
and Include stock. Selecting Automatically detect depth allows you to automatically detect the Z limits when the 
toolpath is processed. This means you do not need to select Detect limit each time you modify the toolpath. 

NOTE
Depending on the 3D toolpath type, some of these new options may be unavailable. 

If you select Include stock, Mastercam includes the stock model defined on the Stock page in addition to the 
geometry defined on the Model Geometry page when manually or automatically detecting the minimum and 
maximum Z limits. 

You can also manually select the Minimum depth and Maximum depth. In previous releases, you had to manually 
enter a value or use data entry shortcuts. Now, you can use the Select buttons to return to the graphics window to 
select a depth. These values determine the highest point and the lowest (deepest) point on your part that you want 
to machine.

What's New in Mastercam 2023—Milling Enhancements
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Setting the Entry and Exit Move Helix Arc Height
The Linking Parameters page of 3D high speed toolpaths now includes the Ramp angle parameter. Ramp angle 
was previously only available to Dynamic OptiRough, Area Roughing, and Horizontal Area toolpaths. This option is 
now included with all 3D high speed toolpaths. When you enter a value other than zero for the Horizontal arc 
entry parameter, the entry move becomes a small helix when moving into a new region. Ramp angle sets the 
height of this helix.
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Adding Stock Awareness to Holder Checking
Dynamic OptiRough, Area Roughing, and Horizontal Area toolpaths with Rest material enabled on the Stock page 
are now aware of stock outside of the containment boundary when Collision checking is enabled on the Holder 
page.  Previous versions of Mastercam did not check against any portion of the stock model that existed outside of 
the containment boundary. 

 

Machining from Bottom to Top
You can now machine bottom to top with a 3D Waterline toolpath with a separate Cut order. In previous releases, 
Bottom to top was part of the Cut order parameter. In Mastercam 2023, Bottom to top is now a selectable option 
that respects both By depth and Optimize. The images below show a Waterline toolpath with Cut order set to 
Optimize. Notice the starting locations for both toolpaths.

Bottom to top off Bottom to top on 

What's New in Mastercam 2023—Milling Enhancements
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Machining at Maximum Depth
The 3D high speed Dynamic OptiRough toolpath now machines a pass at the defined Maximum depth, set on the 
Steep/Shallow page when Rest material is selected on the Stock page. In previous releases, this pass was not 
machined when rest roughing against stock models if the Maximum depth was defined below the stock model 
shape.

2D Toolpath Enhancements
Listed below are enhancements to 2D milling toolpaths. 

Removing Restrictions with Slot Mill Geometry  
The Slot Mill toolpath no longer requires two parallel walls when selecting the machining geometry. You can select 
any closed chain. In previous releases, Mastercam would display an error stating that the boundary must be closed 
and include two parallel, straight sides. 
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Overriding the Feed Rate for Profile Ramp Entry and Exit 
2D Contour now supports the Override feed rate option, which allows you to specify a feed rate for the entry or 
exit move, when Entry or Exit is set to Profile ramp. 

 

Dragging and Dropping for the Hole Making Toolpaths
When you drag-and-drop items in the Toolpath Hole Definition panel, Mastercam now provides visual cues for the 
drop location. Also, the drag-and-drop icon now indicates whether you are dragging a single item or multiple items.

What's New in Mastercam 2023—Milling Enhancements
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Multiaxis Toolpath Enhancements
Listed below are enhancements to Multiaxis toolpaths. 

Consolidating Multiaxis Toolpaths 
Morph, Parallel, Along Curve, and Project Curve are no longer individual toolpaths in Mastercam.   Instead, the 
Unified toolpath allows access to these cut patterns when you add the appropriate curves. For example, to create a 
toolpath that morphs between two surfaces, select Unified from the Multiaxis toolpaths, and then set the Cut 
Pattern to two surfaces with the Morph style, as shown in the following image: 

Toolpaths in files from previous releases are automatically converted to a Unified toolpath as follows: 

 l Morph—Becomes the Unified toolpath with a Cut Pattern of two curves or surfaces with the Morph style.

 l Parallel—(set to Curves or Surface): Becomes the Unified toolpath with a Cut Pattern of one curve or 
surface with the Parallel style.

 l Parallel—(set to Angle): Becomes the Unified toolpath with a Cut Pattern of Plane with the style set to the 
appropriate plane.

 l Along Curve—Becomes the Unified toolpath with a Cut Pattern of Curve with the Perpendicular style.

 l Project Curve—Becomes the Unified toolpath with a Cut Pattern of Curve with the Project style.

New Feed Rate Control Page
Mastercam 2023 features a new Feed Rate Control page for Mulitaxis toolpaths. This page consolidates the feed 
rate control options found in the Linking, Miscellaneous, and Utilities pages, making the options easier to find 
and simplifying your workflow. You can find this page in a toolpath’s parameters dialog box, as shown in the 
following picture. 

NOTE
The contents of this page may change, based on the selected toolpath type. 

What's New in Mastercam 2023—Milling Enhancements



Replacing Rapid Motion with Feed Rate

Rotary Advanced toolpaths now include a new Replace rapid with feed option on the Feed Rate Control page, 
providing better control over rapid conditions by setting a feed rate for clearance area and rapid distance moves. 

What's New in Mastercam 2023—Milling Enhancements
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Setting Feed Rates as a Percentage or Direct Value 

You can now set feed rates by either the percentage of the machining feed rate or the feed rate itself, allowing 
easier control of these values. Previously, you could adjust the feed rates only by percentage. Entering a value in the 
percentage parameter or the feed rate parameter automatically updates the other. 

What's New in Mastercam 2023—Milling Enhancements



Controlling the Guide Curve Across Machining Geometry
The new Propagation direction parameter on the Guide Curve - Advanced Parameters page for Unified 
toolpaths allows you to control which way the guide curve propagates across machining geometry. 

The Guide Curve - Advanced Parameters page is available when the Pattern is set to Automatic or  to Curve, 
Guide.

Specifying Connection Moves Between Cuts
The Linking Parameters page for Pocketing and 3+2 Automatic Roughing toolpaths now includes the Within 
group option. Use this option to specify connection moves between the offset cuts in a single group, providing 
easier manual control over some retract behaviors.

 

What's New in Mastercam 2023—Milling Enhancements
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Controlling Rapid and Linking Moves
The new Angle step options for Pocketing and Deburr toolpaths allow you to control the angle step of rapid and 
linking moves. In Pocketing, you can find these options on the Linking page when you select Interpolation tilt 
angle. In Deburr, select the Tool Axis Control page and set Machining type to 5 axis (simultaneous). Then go to 
the Linking page and set Type to Cylinder or Sphere.
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Controlling the Tool Contact Point
The Deburr toolpath now includes a new Fixed tool contact point on cone/cylinder option, which controls the 
tool's contact point during machining. This new option is on the Tool Axis Control page. Deburr attempts to use 
the specified contact point, which is a percentage of the flute length of the cylindrical portion of the flute, on any 
supported ball, taper, or end mill tool.

What's New in Mastercam 2023—Milling Enhancements
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Driving the Tool Axis Control from Another Surface
The Tool Axis Control page for Multiaxis toolpaths now includes the Tilt relative to reference surface option in 
the Tool axis control drop-down. This option lets you drive the tool axis control from a another surface, including 
surfaces that are shaped differently than the machining geometry. 

What's New in Mastercam 2023—Milling Enhancements
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TURNING ENHANCEMENTS

Listed below are major enhancements to the Lathe and Mill-Turn products.

NOTE
Unless otherwise stated, the new features and functionality listed in this section apply to both Lathe and 
Mill-Turn licenses.

New B-Axis Contour Turning Toolpath
Mastercam 2023 introduces a new toolpath to the Turning suite for the Mill-Turn product. B-Axis Contour Turning is 
a finishing toolpath that allows for rotation of the B-axis while the tool is cutting. This new toolpath can be found in 
the General gallery on the Mill-Turn Turning contextual tab. 
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The B-Axis Contour Turning toolpath features a top-down workflow, represented by the icons on the left side of the 
panel. 

Select from two toolpath types on the Basic Motion Control page: Automatic or Manual. 
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Automatically Create the Toolpath Motion
Automatic mode produces safe toolpath motion that keeps the insert in contact with the contour. The Tool Angle 
Limits expander offers quick restriction of the angles that the toolpath is allowed to travel within.

What's New in Mastercam 2023—Turning Enhancements
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Manually Control the B-Axis Angles
Manual mode offers the user full control over the B-axis angles along the contour.  After choosing Manual, a 
selection list box automatically expands to quickly select tool axis control lines.  If necessary, you can use the Tool 
Offset Angle parameter to define an offset from the lines. 
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Adjusting the Toolpath Motion for Both Modes
For both Manual and Automatic mode, use the Advanced Motion Control page to control the finer details of 
toolpath generation.

What's New in Mastercam 2023—Turning Enhancements
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Supporting Multiple Steady Rests
Mastercam 2023 extends the steady rest support in Mill-Turn to include multiple standalone, machine-mounted 
steady rests. Mastercam's modular machine definition architecture means that you can organize your steady rests 
in several different configurations.

Using Multiple Standalone Steady Rests
Large CNC mill-turn machines often include multiple steady rests that can be individually positioned. These can 
support individual work pieces at multiple points. This configuration is represented in Mastercam by two separate 
steady rest components each attached to their own linear axis components, letting you program and position them 
independently.

You are not limited to two steady rests; machine developers can create as many as needed to support very long 
parts.  Developers can also select in which stream the commands for each steady rest will be output.

Using Tandem Steady Rests
Tandem steady rests are another common configuration; these consist of several steady rests mounted so that they 
move together. This configuration is represented in Mastercam with multiple steady rest components connected to 
the same linear axis components. Even though the steady rests move together, while programming your part you 
can still clamp/unclamp each steady rest independently with individual steady rest operations for each component.

What's New in Mastercam 2023—Turning Enhancements



Using Multiple Tandem Steady Rests
Mastercam's modular architecture means that even more complicated applications can be supported. For example, 
you can include multiple tandem steady rests.

What's New in Mastercam 2023—Turning Enhancements

42



43

Again, organizing the components in Mastercam's machine definition is straightforward. In this case, create 
multiple sets of linear axis components and link multiple steady rests to each one. This lets you move each set of 
tandem steady rests independently of the other.

Programming Multiple Steady Rests
Machines with multiple standalone steady rests use the same steady rest operation introduced for single steady 
rests in Mastercam 2022. However, the interface has been enhanced in a couple of ways.

The Driven Component list lets you select which steady rest is being programmed when multiple steady rests are 
available.

What's New in Mastercam 2023—Turning Enhancements



Once you select the primary steady rest for the operation, you can select additional steady rests that are linked to 
the primary steady rest and move with it. Mastercam automatically detects the available steady rests and displays 
them here. You can select as many as eight linked steady rests.

Steady rests that are output in the same stream can be programmed in this way. If the steady rests are in different 
streams, the operations can be synced in the Sync Manager.

What's New in Mastercam 2023—Turning Enhancements
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Incorporating Multiple Steady Rests in Operation Strategies 
Mastercam 2023 also lets machine developers incorporate multiple steady rests in Mill-Turn part handling 
strategies. The interface for adding steady rest operations to a part handling strategy has been enhanced so that 
developers can select which steady rest will be driven by the operation as well as any linked steady rest 
components. Developers can select steady rests from any stream. The Operation Strategies editor has also been 
enhanced with a new Active Spindle setting; see "Setting a Base Spindle for Steady Rest Operations" on the next 
page.

End users can access these same settings when they select the strategy while programming their part. The initial 
settings come from the strategy but the user can edit them if desired:

What's New in Mastercam 2023—Turning Enhancements



Setting a Base Spindle for Steady Rest Operations
The Operation Strategies editor now lets machine developers select a base spindle for outputting steady rest 
operations. The steady rest positions will be output relative to the selected spindle origin. 

Supporting Transform Subprograms in Mill-Turn
Mastercam 2023 includes support for transform subprograms in Mill-Turn, building on the general subprogram 
support introduced in Mastercam 2022. The same subprogram options that are available in Mill and Lathe are now 
available in Mill-Turn when creating your transform operations:

Creating Part Handling Operations That Use the Active Tool Plane
In Mill-Turn, manually created part handling operations now use the active tool plane by default. This provides a 
more consistent Mastercam experience by matching the behavior of part handling operations in Lathe.  
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Displaying the Stock Preview Directly from the Ribbon 
Mastercam 2023 features a secondary location for the Stock Preview button on the Turning contextual tab  for 
Lathe and Mill-Turn. Use this function to display the machined stock, chuck, tailstock, and steady rest boundaries 
with a single click. 

 

As with earlier versions of Mastercam, you can still access Lathe stock preview and Turning stock preview from 
the right-click menu of the Toolpaths Manager.
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DESIGNING ENHANCEMENTS

Listed below are major enhancements to designing functions.

Organizing Your Solid Models into Groups
Mastercam 2023 enhances groups functionality in the Solids Manager with a new button in the  toolbar and support 
for nested groups. The new Add group button lets you quickly create a group at the top level of the Solids Manager 
without using right-click menus.

The Solids Manger also includes support for nested groups to help you organize your work with solid models. To 
create a sub-group folder, right-click an existing group folder and select Group, Add from the menu. Then, click on 
the nested group to create a new body, or drag and drop existing items into the sub-group.  Right-click a nested 
group folder and select Group, Move to top level from the menu to promote the group in the Solids Manager.

When you import solid models that include assemblies, sub-assemblies, and component parts, Mastercam 2023 
automatically creates groups and sub-groups. These groups and the intuitive naming conventions they use will help 
you better manage the relationships between the solids in Mastercam.

Improving the Selection Workflow
Multiple Wireframe and Surfaces function panels now include a new selection grid for surfaces and chains, 
providing easier editing during the creation process. This applies to the following functions:

Surfaces functions
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 l Trim to Plane

 l Fillets to Plane

 l Trim to Curves

 l Fillets to Curves

 l Trim to Surface

 l Fillet to Surface

Wireframe functions
 l Spline Automatic

 l Curve at Intersection 

Spline Automatic includes a selection grid for manual and automatic points. Manual points are defined by you 
to set the pattern of the spline. This includes the start point, direction point, and end point. Automatic points 
are used by Mastercam to define the spline. You can remove or add to these points. In previous releases, you 
had to exit the function and start over to make modifications. 
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Creating Additional Geometry Types 
You can now create a mesh, surface, or sheet solid in Wireframe and Surfaces functions. In previous releases, you 
could only create surfaces inside wireframe functions which resulted in a closed shape or you had to create a 
surface and convert it. 

This applies to the following functions: 

Wireframe functions
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 l Circle Center Point

 l Circle Edge Point

 l Rectangle

 l Polygon

 l Ellipse

 l Rectangular Shapes

Surfaces functions
 l Draft

 l Lofted/Rules

 l Extrude

 l Revolved

 l Flat Boundary

 l Two Surface Blend

 l Three Surface Blend

 l Swept

 l Net

 l Fence
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 l Offset

 l Three Fillet Blend

 l Power Surface

 l Fill Holes

Creating a Cylinder with Unknown Base Points
Primitive Cylinder now includes Base Point Definition options. These new options allow you to create a cylinder 
without knowing in advance where the center point is. 

You choose between two Methods:

 l Manual: Creates the cylinder according to your selected options and positions. 

 l Tangent: Creates the cylinder tangent to existing entities, according to the selected options. 

Then, you can choose between the following:
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 l Center point: Select a center point and set the radius. This is the default arc method. 

 l Two edges: Select two edge positions that the cylinder's diameter passes through. The edge positions 
determine the center point location. 

 l Three edges: Select three edge positions that the cylinder's diameter passes through. The edge positions 
determine the center point location.

 l Endpoints: Select two edge positions and an edge point to define the cylinder's center point and edges. 
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 l Geometry: Select an arc or radial face that defines the center and the radius of the cylinder. 

Mesh Enhancements
Listed below are enhancements for the functions located on the Mesh tab. 

New Offset Mesh Function
To offset a mesh entity in previous versions of Mastercam, you had to create a stock model operation and then 
convert the stock model to a mesh. Mastercam 2023's new Offset Mesh function offers you a quick and easy way to 
achieve the same outcome. 

To start the function, select Offset Mesh from the Mesh tab. 
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Then, select the mesh or meshes you wish to offset, and enter a positive Offset distance. Mastercam uses a 3D 
spherical offset to create new meshes or modify existing ones. 

Automatically Check and Fix Mesh Results  
The Smooth Free Edges, Fill Holes, Smooth Area, Refine, and Decimation functions now warn you during 
Preview or creation if you are creating a problematic facet. 

If you click OK or OK and Create New Operation, a dialog box displays. You can delete the problematic facets at 
that time or keep them. Mastercam also marks these facets using a red point in the graphics window, however 
these indicators are removed after selecting Yes or No in the dialog box. 
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Check Mesh Enhancements
Listed below are enhancements made to the Check Mesh function. 

Deleting Problematic Facets

Check Mesh now includes a new option to delete problem facets. By selecting this option, Mastercam deletes all 
facets identified with errors.
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Detecting Folded Facets

Check Mesh now detects folded facets, where a neighboring node is pulled over an existing facet, creating a crease 
which has no geometric meaning.

Correct Incorrect

If Check Mesh discovers a folded facet, Mastercam marks the bad facet with a round-style point indicator.
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New Trim to Chain Function
The new Trim to Chain function allows you to trim selected mesh entities by a single chain, using the current 
Cplane for the direction. Additionally, you can split the mesh where it intersects with the chain and create caps by 
closing free edges of the mesh created by the trim.

Trimming a mesh is helpful when you need to remove features or create multiple meshes from an individual mesh. 
To start the function, select Trim to Chain from the Mesh tab. 
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Improving Your Facet Selection
Facet selection for Decimation, Refine, and Smooth Area has been improved. You can now select facets by color 
using the new Color Masking options in the Facet Selection fly-out. Color masking allows you to select facets that 
match the colors you select, saving time by having Mastercam automatically select the facets for you. The Sample 
facets button allows you to precisely add or remove a facet color from the masking list if your mesh contains 
entities with subtle color differences. 
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Automatically Split Meshes 
Explode Mesh now includes the new Split disjointed mesh option. This new option automatically separates the 
mesh model along existing disjointed areas, instead of using the calculation fields. If you select this option, the 
Flatness, Edge angle tolerance, and Merge percentage parameters are disabled. 

Additionally, the boundaries between the resulting meshes are more apparent. 
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Selecting Edges to Fill Holes 
Fill Holes now allows you to select edges when selecting holes to fill. Additionally, Fill Holes includes a Preview 
button on the Basic tab, allowing you to see your modifications without leaving the function panel. 

Wireframe Enhancements
Listed below are enhancements for the functions located on the Wireframe tab. 

Spline Enhancements
Listed below are enhancements made to Spline functions. 

Converting Complex Spline Shapes

In previous releases, Simplify Spline had difficulty recognizing more complex spline shapes to convert into arcs and 
lines. In Mastercam 2023, Simplify Spline is aware of these complex shapes, and creates arcs and lines as 
necessary.
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Simplify Spline also includes a Detection angle, which defines the angle at which the node is considered a sharp 
corner.

Modifying Spline Tangencies 

Edit Spline includes a new Relax option. When you edit or delete a node, this new option modifies the  spline as if 
the node was never part of it. In previous releases, when you modified a node point, the pre-existing tangencies of 
the spline did not change.
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The examples below show how the options affect the spline after deleting the node indicated by the red arrow.

Initial Preserve Relax

Creating Planes and Points for Each Curve Slice
Curve Slice by Plane and Curve Slice Along Curve now include the Create plane at each slice option in the 
Advanced tab. When selected, Mastercam creates a plane at each curve slice along the selected chain or plane. This 
allows you to create planes automatically to use for other functions, such as creating a toolpath.
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Curve Slice Along Curve also includes the Create point at each slice option, which creates a point at each curve 
slice on the Along curve that can be reused later to determine where slices will occur.
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Automatically Determine Z Depth
Line Parallel now includes the Automatically determine Z depth option when creating a line using the Point 
method. This option keeps new, non-AutoCursor points at your first endpoint's AutoCursor Z depth. This option only 
applies in 3D mode. 

 

Linear Extension to Splines 
Mastercam has always been able to trim and extend most wireframe entities to one another. However, these 
capabilities did not include splines, which were limited to only trimming. In previous versions, to extend a spline you 
had to use top-level editing (introduced in Mastercam 2022) or Modify Length to extend the spline prior to 
trimming. In Mastercam 2023, the Trim to Entities function now adds a linear extension to splines that intersect 
with other selected wireframe entities.

This is especially useful when you need to clean up wireframe in imported files that contain splines.

2D/3D Construction Mode Support 
Mastercam now includes improved support for switching between 2D/3D construction modes. You can now change 
the  2D/3D mode while some entities are live. This applies to the following functions: 

 l Spline Blended

 l Circle Edge Point

 l Arc 3 Points

 l Circle Center Edge Point (also supports changing the Cplane while the circle is live)
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Model Prep Enhancements
Listed below are enhancements for the functions located on the Model Prep tab. 

Detecting Holes in Solid Bodies
The hole detection capabilities of Add History have been broken out into their own function called Find Holes. Find 
Holes detects holes in one or more solid bodies with no history. When Mastercam detects a hole, use Find Holes to 
detect holes or plugs, and create new operations in the Solids Manager. 

Add History continues to detect fillets and create extrusion operations from round holes on solid bodies. Both 
functions are located on the Model Prep tab. 
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Positioning Solid Bodies
The new Solid Position function, located on the Model Prep tab, allows you to place a solid body against multiple 
solid bodies such as vices or clamps. This eliminates the need for multi-step processes using other functions to 
achieve your goal. This new function uses Mastercam's collision checking technology to accurately place the solid 
against the selected contact bodies. 

To use this function, select a face on the solid body to move and adjust the gnomon to orient the movement along 
its axes. You can rotate the part or use the Vector option to quickly align the part's X axis along a vector that you 
define. Then, select the contact bodies. Contact bodies set the boundaries for the movement of your solid body. 
Use the gnomon to move the body into position. 
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Improving the Workflow for Split Solid Face
Mastercam 2023 introduces a new, clearly defined selection process for splitting faces with wireframe geometry. In 
previous versions, when you used the Wireframe method to split the face, Mastercam prompted you to select both 
the face and the splitting geometry. This was problematic if the wireframe was on top of the face.  In Mastercam 
2023, this process is divided into two distinct steps. Only after you select a target can you select the splitting 
geometry. 
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Providing Consistent Controls and Greater Flexibility 

Split Solid Face includes standard Mastercam controls to reselect the face and trimming geometry. This provides 
more flexible selection and is consistent with other Mastercam functions.

When you select a face to trim, the Target parameter changes to Defined, and the Reselect all button becomes 
active allowing you to choose a different face at any point in the process. Then either the Splitting Geometry or 
Position group is enabled depending on your selected Method. 
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Creating Chamfers with Push-Pull  
Push-Pull now includes the new Chamfer option, which allows you to push the selected edges to create a one-
distance chamfer. Push or pull the selected edges to modify existing chamfers. This new option makes it easy to 
create a chamfer on a solid edge.
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Surfaces Enhancements
Listed below are enhancements for the functions located on the Surfaces tab. 

Creating Consistent Flowlines with Surface Ruled/Lofted
Irregular flowlines on a surface can sometimes occur when the surface is created from independent curves with 
inconsistent point spacing. Connecting these points of constant parameter values, as the Surface Ruled/Lofted 
function does, may produce undesirable flowlines, which may result in an undesirable surface shape. The new 
Dynamic Sync option redefines the way existing points are arranged on the selected chains to produce smoother, 
more consistent flowlines. 

By generating an imaginary spine curve from your selection, Dynamic Sync provides an invisible "backbone" to the 
surface flow. This backbone provides a new set of aligned points to the wireframe chains.
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There are three ways to generate Dynamic Sync's spine curve.

 l From an Average of all the selected chains. The spine curve creates points on the wireframe that are 
perpendicular to it.

 l From an Entity you select. The generated surface uses the selected entity’s point spacing to create points 
that are perpendicular to it on the wireframe.

 l By projecting a set of points on each curve that are perpendicular at the Minimum distance to the one 
before it. Use this option when a spine curve from Average and Entity options cannot be generated or 
produces an undesirable result.

In conjunction with Dynamic syncing capabilities, Mastercam brings additional enhancements to Surface 
Ruled/Lofted that give you more control of your chain selections and your surface creation. Surface Ruled/Lofted 
now includes a selection list which allows you to view the chains you have selected. You can add, remove, reverse, 
or reorder your chains using the right-click menu or dragging and dropping a chain. You can also use the Select 
chains and Reselect chains buttons located below the list box. 
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Supporting Multiple Flow Surfaces in Overflow UV
The original implementation of the Overflow UV function in Mastercam 2022 supported flowline projections from a 
single flow surface. In Mastercam 2023, Overflow UV supports flowline projections from multiple flow surfaces. 
This means you no longer need to re-run the function for each surface you wish to project to a set of target 
surfaces. 

The panel and workflow have been modified to use standard Mastercam selection techniques to add, remove, and 
reselect flow and target surfaces.
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Additionally, Overflow UV now allows live entity conversion so you can quickly create a single mesh or sheet solid 
from multiple target surfaces.

Improving Selection for Trim to Surface and Trim to Curves
The selection for the Trim to Surfaces and Trim to Curves functions have improved for Mastercam 2023. The 
improvements allow for greater flexibility when selecting trimming geometry. 

There are three new buttons: Area to keep, Add selection, and Reselect all for both functions. The Add selection 
and Reselect all buttons can be found throughout Mastercam and they work exactly the same in these two 
functions. The new Area to keep button allows you to change which area should remain if you do not get the 
results you were expecting from your first trimming attempt. 

When trimming with Trim to Curves, occasionally surfaces would be left behind in the graphics window. 
Mastercam 2023 now properly removes these surfaces from the part.

Additionally, the Keep multiple regions option from both functions and the Interference check boundaries 
option in Trim to Curves have been removed. Both functions now create multiple regions by default, and  
improvements to performance and processing have rendered the Interference check boundaries unnecessary.
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Trim to Surfaces now supports the selection of multiple surfaces for both surface sets. In previous releases, you 
were limited to a single surface in one of the sets. When using Split model, Mastercam now organizes the surfaces 
by color. The original surfaces retain their color, but the newly split model inherits the current surface color.
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Drafting Enhancements
Listed below are enhancements for the functions located on the Drafting tab. 

Top-Level Editing of Drafting, Label, and Note Entities 
Mastercam 2023 makes it easier to access and edit notes, labels, and dimensions using top-level editing. In previous 
releases, you could use the Edit text or Quick edit buttons in the Analyze function to modify the text or re-open 
the Note/Drafting functions to edit the text and position. 

Now, if no other function is active, you can double-click existing notes, labels, and dimensions in the graphics 
window to open the Note and Drafting function panels to make edits. 

Modifying Your Drafting Font Directly
The Drafting function panel now includes easier, in-panel methods to modify your font format and placement of 
the drafting entity. In previous releases, you had to select a button to open a separate dialog box to make your 
modifications. This new workflow removes extra steps you took to make modifications.
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Remembering Previous Note Text
The Note function now includes the new Restore text option, which populates the text box with the most recently 
entered text. This new option only restores content entered during the current Mastercam session.
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Improving Visibility for Drafting Dimensions
Mastercam 2023 includes a new single-stroke font with a more pronounced period. Since the introduction of the 
now default OLF SimpleSansCJK OC TrueType font, the period in dimensions has been hard to distinguish and 
potentially causing confusion. An font with a more pronounced period is now included with Mastercam 2023. This 
new font is called OLF SimpleSans CJKP OC. The P in the name indicates the enhanced period. 

OLF SimpleSansCJK OC OLF SimpleSans CJKP OC

Including Dimensions When Aligning 
The Align Note function now includes the alignment of dimensions. Previously, Align Note only affected notes.

Transform Enhancements
Listed below are enhancements for the functions located on the Transform tab. 

Projecting Dimension Entities
You can now project dimension entities using the Project function to a new Z depth. In previous releases, you could 
use Translate or Dynamic to move the dimensions. However, if your file contained multiple dimensions at different 
depths, you needed to repeat the process multiple times. Project allows you to select all dimensions and project 
them to a single depth with one operation.

The image below depicts two dimension entities, which were located at different depths, projected to the same 
Depth. 

When Project To is set to Depth, the dimensions are projected to the entered value. If set to Plane or 
Surface/Solid, the dimensions do not move from their current depth.
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Easily Enter X, Y, and Z Values While Manipulating Geometry
You can now easily enter values when using Translate or Stretch on geometry. When you hover over an axis of the 
Dynamic Gnomon, Mastercam automatically activates that field in the function panel. Once the field is active, you 
can then enter the X, Y, or Z value without having to click in the graphics window or in the function panel. This 
reduces the amount of clicks and mouse travel needed to use these functions.
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Improving the Plane Selection for Translating to Plane
Translate to Plane now uses the new Plane Selection fly-out panel when selecting a plane to move or copy 
entities. You no longer need to navigate through a separate dialog box. 
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Remembering the Last Dynamic Transform Operation
The Only apply last transform option is now located on the Advanced page of the Dynamic function panel. This 
option applies only the last transform operation when you make multiple transform edits in a session. 
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SIMULATION ENHANCEMENTS

Listed below are major enhancements to Mastercam Simulator.

Appending Operations to a Current Mastercam Simulator Session 
Mastercam 2023 now includes  the ability to add operations to the current verify session. When verifying, you can 
add more operations using the Verify selected operations drop-down in the Toolpaths Manager. From this drop-
down, you can choose to  Add to the current verification or Verify the selected machine group. The Verify 
selected operations button behavior is the same as previous releases. 

There are restrictions when adding an operation to a current session:

 l Only operations positioned below the selected operations in the Toolpaths Manager can be added to the 
current session.

 l Operations that depend on a previous operation cannot be added unless the parent operation is also 
selected.
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Improving the Overall Processing Speed 
Mastercam 2023 includes overall processing speed and time to load data into Mastercam Simulator. These 
improvements only apply to milling toolpaths (2D, 3D, and multiaxis) and are particularly helpful for files that 
contain large toolpaths. If you are experiencing performance issues, you may wish to disable the processing using 
the Disable GPU processing option in the Simulation page of the System Configuration dialog box. 
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Setting Your Collision Checking Options
Mastercam Simulator includes improvements to collision checking while in Verify mode and Simulation mode. In 
previous releases, collision checking options were set in the Options dialog box. You could then toggle collision 
checking in the Verify or Simulation tab. In Mastercam 2023 the collision checking options have been removed 
from the Options dialog box and can now be accessed directly using the dialog box launcher on the tab. 

The Collision Checking drop-down lets you select the types of collisions to detect. Depending on your selected 
machine and if you are in Verify or Simulation mode, you may see different options. 
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Viewing Rotational Axis Jumps During Simulation 
If you have large jumps in the rotational axes, you can select the new Tool Center Point Control options in the 
Simulator Options dialog box to define a linear interpolation around the tool tip or spindle head.

Select Tool Center Point Control to enable the options. Then set the following: 

 l Maximum distance: Sets the maximum length segment to create between interpolated points.

 l Maximum angle change: Sets the maximum angle difference between subsequent positions.
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TOOLPATH UTILITY ENHANCEMENTS

Listed below are major enhancements to toolpath utilities, including the Toolpaths Manager and stock model. 

Displaying Dirty Toolpath Motion in the Graphics Window
Mastercam 2023 includes the new Dirty Toolpath Motion option in the Advanced Display. This option allows you 
to view the original toolpath motion even though the operation is dirty. In previous versions of Mastercam, once a 
toolpath went dirty, the toolpath motion would disappear from the graphics window. 
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To view dirty toolpath motion, select Dirty Toolpath Motion in the Advanced Display drop-down. 

As with all options in Advanced Display, you can edit the color and attributes of dirty toolpath motion. Use the 
Advanced Toolpath Display page of the System Configuration dialog box or select the dialog box launcher under 
Advanced Display in the View tab.

Copying and Moving Operations with the Left Mouse Button 
Mastercam 2023 displays options during left-click drag-and-drop of operations in the Toolpaths Manager. 
Previously, left-clicking on an operation and dragging it to a location in the Toolpaths Manager moved the 
operation, but did not result in a prompt or alert you of the move. This enhancement gives you more control when 
moving or copying operations and prevents unintentional movement of operations within the manager. 
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Importing Toolpath Operations from Recent Files
When importing toolpath operations into Mastercam 2023, the Select Operations File button includes a drop-
down menu listing recently imported operations libraries. Improve your workflow by selecting an operations library 
from the list, instead of navigating with the file explorer. 
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Viewing Plane Name Tooltips
Mastercam 2023 displays plane names as tooltips in the Toolpath Coordinate System dialog box, making it easier 
to select the correct plane when editing an operation. This change is consistent with the behavior of plane names in 
other areas of Mastercam. 

You can access the Toolpath Coordinate System dialog box from the Edit Common Parameters right-click option 
in the Toolpaths Manager, and then select Planes. 
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SYSTEM ENHANCEMENTS

Listed below are enhancements made to Mastercam's core features, including graphics, planes, and levels. 

Dynamic Plane Enhancements
Listed below are enhancements when creating a dynamic plane. 

Creating Associative Dynamic Planes
Mastercam includes the ability to associate dynamic planes to geometry (including wireframe, solids, meshes, and 
surfaces) and to set the plane origin to any point on the geometry. Dynamic plane creation now consolidates the 
many ways of creating planes within Mastercam, making planes easier and faster to use. Previous versions of 
Mastercam only allowed planes created from entities to associate to geometry, and the plane origin was in the 
center. 

You can now set the dynamic plane origin to any point on the selected geometry and can associate a dynamic plane 
to geometry:

 l Associate the plane Orientation to solids, meshes, and surfaces.

 l Associate the plane Origin to wireframe, solids, meshes, and surfaces. 

Transforming geometry with an associated plane:
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Transforming geometry with an unassociated plane: 

To create a dynamic plane, select Dynamic from the Create a new plane drop-down in the Planes Manager or click 
the Dynamic Gnomon in the lower left corner of the graphics window. By default, new planes automatically 
associate to the selected geometry. When editing an existing plane, Mastercam asks if you wish to associate the 
plane origin to geometry. You can change the default settings for planes associativity in the new Planes page of the 
System Configuration dialog box. 

NOTE
At any point in your Mastercam session, you can remove the plane associativity by deselecting the 
checkboxes in the Settings group of the Advanced tab in Edit/New Plane.

What's New in Mastercam 2023—System Enhancements

92



93

Creating Dynamic Planes with Normal Orientation
Mastercam 2023 includes normal support for the Dynamic Gnomon. During dynamic plane creation, moving your 
cursor along wireframe geometry results in the Z axis of the gnomon orienting to the normal of the geometry. 
When possible, Mastercam also orients the X axis of the gnomon along the tangent to the geometry. This feature 
helps you to orient your planes faster, resulting in less mouse movement and increased productivity.

Grouping Viewsheets in Mastercam
Mastercam 2023 gives you the ability to create viewsheet groups. Use viewsheet groups for better viewsheet 
organization, more efficient workflow, and reduced on-screen clutter. 
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To add a viewsheet to a group, right-click on the viewsheet. Select Group, New group to create a new group or 
choose an existing group. To remove a viewsheet from a group, right-click the viewsheet and click Ungroup.

You can also select multiple viewsheets  to group or ungroup by pressing [Shift] and then selecting the viewsheets, 
or using the right-click menu. 

When you create a new group, Mastercam prompts you to customize the group name and color. You can edit these 
at any time by right-clicking on the group tab and selecting Rename or Color.

Another way to add a viewsheet to an existing group is by dragging-and-dropping it between the group tab and any 
group member. Similarly, you can remove a tab from a group by dragging it outside of the grouped viewsheets. To 
expand or collapse a group, click on the group tab. The folder icon displays as open or closed depending on the 
group status. 
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Configuration Enhancements 
Listed below are enhancements made to the System Configuration dialog box. 

Configuring Your Planes Settings 
The new Planes page allows you to customize the association between new planes and selected geometry using the 
new Plane association options. Use these new options to set the default associativity behavior for planes and 
selected geometry. This new page also includes the Planes work offset conflicts options previously located on the 
Toolpaths page. 
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Adjusting the Degree of Rotation for the Graphics View
Mastercam 2023 allows you to set the number of degrees Mastercam rotates the graphics view when you hold [Alt] 
and press an arrow key. This feature provides more control over how you view your part. 

Set the degree of rotation by entering a value between 0 and 360 into the Rotation factor (degrees) option in the 
View page. You can use this value for a single Mastercam session, or save your changes to the configuration file for 
future use. 

Customizing the Geometry Display
Exercise greater control over geometry appearance in the graphics window using the new Geometry Display page. 
This page condenses geometry-related options from the Colors and Advanced Toolpath Display pages, making it 
easier for you to customize your geometry from a single location. You can also edit the default size of Arc Center 
Points and Endpoints, making it easier to view them in the graphics window. 

You can also access this page from the Display group of the Home tab.
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Including Comments with Defaults from a Previous Operation
Save time and create more consistent operation comments by using the new Include comments option. This 
option, in the Toolpaths page, allows you to carry over comments in the Tool page of an operation's parameters to 
subsequent new operations of the same type. Include comments is available when you select Get defaults from 
previous operations.

Selecting a Language for the Mastercam Installation
The Mastercam 2023 installation process features language packs for installing Mastercam in a non-English 
language. Language packs are files that you download separately from the Mastercam installer and select during 
the installation process. If you wish to install Mastercam 2023 in English, you do not need to download an additional 
language pack. Language packs enhance the language selection process while minimizing the download size. 

Before installing Mastercam, download the desired language pack and place it in a secure location on your 
computer. Contact your Reseller if you need assistance acquiring a language pack. Follow the instructions in the 
Mastercam installer to complete the installation.

Mastercam can only be installed in one language at a time. If you want to run Mastercam in a different language, 
run the installer again and select Modify. The installer will take you through the installation process again and you 
can select a different language pack.
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Auto Scaling of Temporary Planes During Functions
Mastercam 2023 automatically scales the size of temporary planes during functions, such as Curve Slice Along 
Curve. Zoom in or out in the graphics window and the planes scale based on the size of the part geometry. This 
feature makes it easier to view temporary planes while you are working within functions that use them.
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Importing Viewsheets for Merged Files
When merging part files using the Merge Pattern function, you can merge incoming viewsheets into the target 
part file using the Merge viewsheets option. If there are duplicate viewsheet names, Mastercam appends a 
number to the viewsheet name. 
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Customizing the Right-Click Menu 
Mastercam 2023 has improved the customization of the context (right-click) menu. The options  now align with the 
options available for customizing the Mastercam ribbon including the ability to reset a customized right-click menu 
to factory defaults. Common options in the right-click menu of Context Menu list box can now be accessed from 
the dialog box. These enhancements lead to a more consistent Mastercam experience, and make it easier to 
customize the interface to meet your needs.

To customize the context menu, select File, Options and click the Context Menu page.
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Displaying Tooltips Longer
Ribbon tooltips in Mastercam 2023 display five times longer than in previous versions of Mastercam. This is 
particularly useful for reading long tooltips and is consistent with the display time of tooltips in other areas of 
Mastercam. 
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MACHINE SYSTEMS ENHANCEMENTS

Listed below are enhancements made to Mastercam's machine systems. 

New Workflow and Interface for Managing Your Machine Groups 
Mastercam 2023 introduces the new Machine Group Setup function panel for Mill and Router machine groups. 
This new function panel encompasses features and functionality from the Machine Group Properties dialog box, 
including new features. These changes continue Mastercam's effort towards kinematic awareness. 

The previous locations where geometry and job setup information, such as stock, fixtures, and machine definitions 
were set  have been consolidated into one location, making it easier for you to work with your part. The Machine 
Group Setup function panel opens when you select Files, Tool settings, or Stock setup under Properties for a Mill 
or Router machine in the Toolpaths Manager. 
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This new interface includes everything you need to set up your part, including parameters for Mastercam Simulator. 
The function panel has seven pages, providing a top-down structured workflow from setting your machine 
definition to choosing the machine that is displayed during simulation. 

 1. Machine—Specifies the names and data paths of files needed by the operations in the machine group. This 
includes the machine definition and operation defaults.

 2. Master Model—Defines the final part (called the master model) after all machining is complete. This page 
also includes engineering information, such as the material. 

NOTE
You do not need to define a master model. However, defining a master model provides workpiece 
data for Mastercam Simulator, ensuring that you always have a workpiece defined.

 3. Stock Setup—Defines the stock model. Stock models help you visualize your toolpaths more realistically in 
the graphics window. The defined stock model can also be displayed with the part geometry when viewing 
the file or toolpaths, or during Mastercam Simulator.

 4. Workholding—Allows you to select fixtures and other workholding components with your master model and 
stock. These components then translate into Mastercam Simulator as Fixtures, which you can use for 
collision checking.

 5. Tools—Controls how Mastercam assigns tool numbers, tool offset numbers, and default values for feeds, 
speeds, coolant, and other toolpath parameters.

 6. Simulation—Allows you to modify the machine that is saved with your Mastercam machine definition 
(*.mcam-mmd) for use with Mastercam Simulator.

What's New in Mastercam 2023—Machine Systems Enhancements

104



105

Encrypting Your Posts 
The MPBin Utility, used to encrypt posts and link them to specific HASP or license numbers, has been expanded for 
Mastercam 2023. 

 l You can encrypt a post so that it will run on any Educational license, in addition to specific license numbers 
that you choose. 

 l You can now require that users have active Maintenance to run a post. You can add this requirement to any 
other encryption option. 

The License Entry dialog box has also been enhanced so you can enter either license numbers (HASP, NetHASP, or 
software license numbers) or customer IDs (unique to each customer). Using customer IDs lets you support users 
whose license might change; in previous versions of Mastercam, you would have had to use MPBin for each 
individual post for each different license.

As in past versions, you can store lists of IDs in text files so that you can reuse them. The format of the text file has 
changed slightly to accommodate the different license types. Each line in the file should have two comma-delimited 
values, where the first value is 0 for a license number or 1 for a customer ID. For example:

 l 0, 12345

 l 1, 67890
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Existing text files can be used without modification. If the line contains a single value, it will be processed as a 
license number.

Improving the Experience of CD Compare and MD CD PST Rename
Mastercam's CD Compare and MD CD PST Rename add-ins have been redesigned for Mastercam 2023 with fresh, 
streamlined interfaces. 

The CD Compare add-in lets users quickly compare control definition and post text settings, even when the original 
files are from different versions of Mastercam:
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The MD CD PST Rename add-in lets users rename the machine definition, control definition, or post (with either a
 .PST or .MCPOST extension) while preserving the links between all the files. In addition, for Mastercam 2023, the 

add-in has been enhanced so that it can back up your original files to a .mcam-content file.
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FILE MANAGEMENT ENHANCEMENTS 

Listed below are enhancements to file usage and converters in Mastercam. 

Compressing and Extracting Mastercam Files
Mastercam's new Zip2Go Wizard leads you through the process of compressing and extracting Mastercam files, 
and allows you to customize the file types and machine groups in the package. Use the Zip2Go Wizard to send 
small file packages to technical support and other Mastercam users. 

The Zip2Go Wizard replaces the Zip2Go utility. To access the new wizard, select File, Zip2Go.

The Zip2Go Wizard lets you create, edit, or extract Mastercam file packages that are in .mcam-content, .z2g, or .zip 
format. 

 l Create compresses your Mastercam files with the settings you choose. You can compress the entire set of 
files or individually select components to exclude or include. 

 l Edit displays the contents of a file package, as well as their current location within the file structure and the 
location to which Mastercam will extract them. Previously, you could only view the contents of an .mcam-
content file by changing the file extension to .zip. 

 l Extract opens a file package in Mastercam. By default, Mastercam extracts all files in the selected package. 
To extract specific files, select an individual file or use [Shift+click] to select multiple files.
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Better Quality of Imported and Exported CAD Files
Mastercam now improves the importing and exporting of several CAD file formats resulting in increased data 
quality, an improved user experience, and a lower support burden. This affects the following file formats:

 l STEP

 l SOLIDWORKS

 l Solid Edge

 l Autodesk Inventor LT

 l ACIS-kernel-based CAD formats (SAT, SpaceClaim, Alibre Design, and KeyCreator)

 l JT and 3DXML (new for Mastercam 2023)

Mastercam is now able to import wireframe geometry and 3D annotations from SOLIDWORKS, Inventor, and Solid 
Edge files.

Files from SOLIDWORKS and Autodesk Inventor no longer need software to import functional data. This 
enhancement fixes an issue in previous releases where conflicting versions of the SWDocumentMgr.DLL affected 
the proper import of SOLIDWORKS files.

In previous versions of Mastercam, there were often issues importing data (sketch data for SOLIDWORKS, colors, 
annotations, and assemblies for Autodesk) if you did not have the product installed or the proper file versions. 

Mastercam 2023 can also import all solids saved in a SpaceClaim assembly file. Previous versions of Mastercam 
would only import these assemblies as a single solid. 

Improved Quality for Importing and Exporting of 3D Annotations 
Mastercam is now able to import wireframe geometry and 3D annotations from SOLIDWORKS, Inventor, and Solid 
Edge files and export 3D annotations to IGES and AutoCAD DWG/DXF files. 3D annotations in Mastercam are written 
to IGES files as copious data (type 106) entities and to AutoCAD DWG/DXF files as line entities within AutoCAD 
Blocks.

Additionally, semantic data from Surface Finish 3D annotation types is now imported. Once imported, you can view 
the annotation attributes using the Analyze functions.

Exporting Drafting Entities to STEP Files
You can now export dimensions and notes to the STEP file format. The dimensions and notes will be written to the 
STEP file as 3D annotations. Previous versions of Mastercam could only export these entities to IGES and AutoCAD 
DWG/DXF.

Quickly Find a 3D Annotation Associated with an Entity
Mastercam 2023 includes a new add-in, 3DAnnotationFinder, that allows you locate all associated 3D annotations 
by selecting the geometry that is related to them. In previous versions of Mastercam, the only way to display this 
relationship was to use the Analyze Entity function and select the 3D annotation itself. 

What's New in Mastercam 2023—File Management Enhancements

110



111

To open the add-in, select Run Mastercam Add-In from the Run Add-In drop-down on the Home tab. Then select 
the 3DAnnotationFinder.dll to open the function. Select a solid face or edge, a surface, or wireframe entity. 
Mastercam highlights the 3D annotation associated with the entity and displays it in the 3D Annotations 
Properties dialog box. Use the Previous and Next buttons to cycle through any other associated 3D annotations, 
including annotations that are not currently visible. 

Enhancements When Importing Solid Models
Mastercam 2023 includes three significant enhancements when importing solid models. 

Healing Stitched Models 
Mastercam's solids importers now heal stitched models. In previous releases, selecting the Use surface stitching 
to import solids option disabled the Attempt to heal solids during import option. In Mastercam 2023, selecting 
either of those options no longer disables the other. This can yield better solid bodies with less effort. 

Automatically Detect Hole Features 
You now have the option to automatically detect Mastercam and create Solid Hole operations when importing solid 
models. Selecting this option shortens the time and work necessary to go from importing to drilling. 

Improved Management of Assemblies, Sub-assemblies, and Component 
Parts
Mastercam 2023 creates groups for imported solid models that include assemblies, sub-assemblies, and 
component parts. These groups and the intuitive naming conventions will help you better manage the relationships 
between the solids in Mastercam. 

Additionally, the Group right-click menu option now includes new options. Use Show, Hide, and Show Only to 
display only components within the currently selected group in the graphics window. 

Newly Supported File Formats
Mastercam 2023 now includes support for the following file formats: JT, 3DXML, AMF, OBJ, and PDF.

 l JT is an open-source 3D file format promoted by Siemens. JT files support solids, meshes, wireframe, and 3D 

annotations. Mastercam 2023 can import JT files, but cannot export in this format. 

 l 3DXML is a proprietary 3D file format developed by Dassault Systèmes. 3DXML files support solids, meshes, 
wireframe, and 3D annotations. Mastercam 2023 can export in this format, however a CATIA V5 license is 
required to import 3DXML files into Mastercam. 
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 l AMF (Additive Manufacturing Format) and OBJ (Wavefront files) are triangular mesh file formats. Importing 
these files types creates mesh entities in Mastercam. Both formats can export surfaces, solids, meshes, and 
stock models. Additionally, the OBJ format exports wireframe geometry as polylines. 

 l You can now import 2D PDF files into Mastercam. PDF (Portable document format) is a proprietary file format 
developed by Adobe. Since PDF files are one of the most used file types today, the ability to import them into 
Mastercam provides you with a ready source of design material for engraving and other operations. Each 
page of the document comes in on a separate level and on a viewsheet assigned to that level. Entities in the 
file come in as wireframe and text.

Mastercam cannot imported 3D PDF data and Mastercam cannot export 2D PDFs. 

Import and export these files with the Open, Merge, Save, Save As, and Save Some functions on the File tab. This 
workflow is the same as any other Mastercam-supported CAD file. 

The Converters page of the System Configuration dialog box lets you set default parameters for conversions to 
and from the .mcam file and these formats. Override these parameters when exporting individual files by choosing 
Options in the Save As dialog box when available. 

Adding Migrated Machine Definition Files to the Machine List 
Mastercam 2023 makes using migrated machine definition files easier  by automatically populating the Machine 
Type drop-down on the Machine tab with migrated machine definition files. In earlier versions of Mastercam, you 
clicked Manage List to select and add machine definition files to the drop-down options.

To do this, select Machine definitions in the File Types page of the Migration Wizard. Follow the prompts to 
complete the file migration.

When you create a new Machine Type, the drop-down includes the migrated machine definitions. 
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Exporting a Stock Model Into Different File Formats
Mastercam 2023 expands the exporting of stock models to more file formats. You can now export stock models to 
the following polygonal mesh formats: 3MF, AMF, and OBJ. In previous releases, you could only export stock models 

as an STL file. 

To reflect this change, the Stock Model Export to STL option in the Toolpaths Manager right-click menu is now 
Stock Model Export to File. The Export to STL option in the Stock Model drop-down on the Toolpaths tab is now 
Export to File. 
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GENERAL ENHANCEMENTS 

Listed below are general enhancements to Mastercam. 

New Mastercam Learning Edition
The Mastercam Demo/Home Learning Edition (HLE) application has been renamed to Mastercam Learning Edition. 
Additionally:

 l You can now run the Check Tool Reach function without restrictions. 

 l You can export Wavefront (OBJ) and Additive Manufacturing Format (AMF) file formats. 

Improving Efficiency When Using Analyze
Mastercam 2023 includes multiple improvements to the Analyze Entity function, including overall speed when the 
Analyze Entity dialog box is open. When using Analyze Entity on a note, you can copy, move, or re-size the note 
using the containment box and a new button in the graphics window. 

When using Analyze Entity on a dimension, you can reposition the text by selecting the dimension again.
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When analyzing a mesh Machine Component Object (MCO), the Analyze Entity dialog box title changes to reflect 
that.

Combining Duplicate Error and Warning Messages
Mastercam lists duplicate errors as a single message followed by the number of occurrences. The message states 
that there were one or more errors or warnings, and then lists them below. This reduces on-screen clutter and 
allows for quicker message review. 

Working with the NET-Script Editor
The NET-Script Editor features multiple enhancements in Mastercam 2023 that make it easier to create, edit, 
compile, and run C# scripts directly inside the software. These enhancements include:

 l The NET-Script Editor is now available on the Home tab.

 l Syntax highlights make the code easier to read and navigate. In addition, a yellow bar displays next to the 
active line of code in the editor to make it easy to see where you left off.

 l Available API keywords auto-complete when you begin to type them, and a tooltip displays information about 
each option. Save time by no longer switching back and forth between the script in Mastercam and the API 
documentation. Along with auto-complete, auto-import is now available for certain options in the API, leading 
to less overhead while typing.
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 l The script names display in the dialog box header of the editor, with an asterisk next to it when unsaved 
changes are present. This is useful for identifying a script when working in multiple editors.

 l Mastercam auto-formats the script when you press [Ctrl+D] to make it easier to clean up your code.

 l Tooltips display for buttons within the editor and you can now set keyboard shortcuts to the editor functions.

CAUTION
Due to the enhanced functionality of the NET-Script editor, VBScript and the VBScript Manager have been 
deprecated and will be completely removed from Mastercam 2024. We recommend that you convert your 
VBScripts to Mastercam NET-Scripts. If you need assistance, contact SDK@mastercam.com. 

Turning a NET-Script into a Mastercam Function
Mastercam 2023 introduces the Script Linker, which lets you create a Mastercam function from a NET-Script. You 
can add the function to the ribbon, Quick Access Toolbar, or contextual menu. The Script Linker saves you time by 
allowing you to launch the script with the click of a button instead of opening it from the NET-Script Editor. 

To access the Script Linker, open the desired script in the NET-Script Editor and select Export As from the Save 
drop-down menu. 

Once the Script Linker opens, create the new function by:

 l Naming the function

 l Entering a tooltip

 l Adding icons

 l Choosing the output location 
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Typically, you want to save the function to the shared Add-Ins folder so that all users of the specific computer can 

access it. However, you also have the option to save the function to the Add-Ins folder in your My Mastercam 
2023\Mastercam\ folder, if you only want the function available during your own Mastercam session. 

Debugging Mastercam .NET-Scripts in Visual Studio Code
The new Mastercam .NET-Scripting extension, for use in Visual Studio Code, is an advanced development feature 
that allows you to debug your Mastercam .NET-script by directly connecting to Mastercam 2023. Run your script in 
Visual Studio Code and watch as it runs line-by-line in Mastercam. Use this extension to find issues and fix defects in 
the .NET-script. You can make changes as necessary in the VS Code editor, and then re-run the script to view the 
changes. 

The extension will soon be available in the Visual Studio Code extensions marketplace. Currently, you can contact 
the Mastercam SDK Team by email to request the extension: SDK@mastercam.com. 

CAUTION
Due to the enhanced functionality of the NET-Script editor, VBScript and the VBScript Manager have been 
deprecated and will be completely removed from Mastercam 2024. We recommend that you convert your 
VBScripts to Mastercam NET-Scripts. If you need assistance, contact SDK@mastercam.com. 
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Storing Third-Party Add-ins Outside of the Mastercam Installation
Mastercam 2023 improves the add-in experience with Run Third-Party Add-in, a function that allows you to quickly 
open third-party add-ins from the ../Documents/My Mastercam 2023/Mastercam/Add-Ins folder.

Store third-party add-ins in this folder when you do not want to require administrator credentials to run the add-in. 
This is particularly useful when multiple users share a workstation. Additionally, this folder is not affected when you 
update or reinstall Mastercam, making it a useful place to store add-ins you use across Mastercam releases. 
Although this folder was included with Mastercam 2022, Mastercam 2023 is the first release to make it accessible 
from the ribbon.

To accommodate this new feature, the Run Add-In button on the Home tab is now a drop-down menu with two 
options: Run Mastercam Add-In and Run Third-Party Add-In. Run Mastercam Add-In functions the same as Run 
Add-In functioned in previous versions of Mastercam.

CAUTION
Due to the enhanced functionality of the NET-Script editor, VBScript and the VBScript Manager have been 
deprecated and will be completely removed from Mastercam 2024. We recommend that you convert your 
VBScripts to Mastercam NET-Scripts. If you need assistance, contact SDK@mastercam.com. 
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Previewing AutoCursor Positions 
When AutoCursor is active,  you can now hover anywhere over a piece of geometry to display multiple AutoCursor 
positions at once: Arc Center, Endpoint, Midpoint, and Quadrant. These positions must be enabled in the 
Selection page of the System Configuration dialog box.  In previous Mastercam versions, you needed to hover 
directly over specific parts of the geometry for an AutoCursor position to appear, and you could only see one type at 
a time. 

 

Improved and Renamed Mastercam Documentation
As part of ongoing efforts to provide documentation that is modern, user-friendly, and easy to search, Mastercam 
2023 features changes to the Administrator Guide, the Mastercam Basics Tutorial, and the Resolved Issues (formerly 
known as the ReadMe). These documents now open in a web browser in an HTML5 format, rather than a PDF. 

In earlier releases of Mastercam, these resources opened as PDFs. You do not need an active internet connection to 
view the website. These changes are in line with recent improvements to other Mastercam documentation, such as 
the What's New and the Help, and are meant to give you a consistent and informative Mastercam experience.

These new formats include new home pages with a card-based interface for quick and easy access to information 
about the most common administrator tasks. You can also use the side navigation to explore the entire resource. As 
with earlier versions of Mastercam, you can access the updated documents from the Start menu.
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Mastercam Resolved Issues
Mastercam 2023 features a single version of the Resolved Issues, with a sub-category for all Mastercam for 
SOLIDWORKS items. Previously you only had access to the Mastercam or Mastercam for SOLIDWORKS versions of 
this document, depending on your installed software. The Resolved Issues also includes improvements such as 
sortable tables, easier filtering capability, and links to notable Mastercam resources. 

Mastercam Basics Tutorial
The Mastercam Basics Tutorial, in addition to the new format, also includes access to the tutorial parts directly from 
the website. This removes the need to navigate through Mastercam's installed files to find the tutorial parts. You 
can also view and download of a copy of the tutorial as a PDF. 
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Geometry and Toolpath Nesting Enhancements 
Listed below are enhancements made to the Geometry Nesting function (on the Transform tab) and the Nesting 
function (on the Toolpaths tab).

Nesting Multiple Corners 
The new Multiple corners parameter for toolpath and geometry nesting uses more than one corner on the sheet 
to nest the parts. Mastercam calculates the job from multiple nesting corners and chooses the corner that yields the 
best outcome. With this new parameter, it is easier to spread the number of required parts evenly throughout the 
sheet for better vacuumed sheet holding.

The Multiple corners parameter is located on the Sheet tab and has four options:

 l Off: Calculates the nesting strategy from the Nesting corner.

 l Flipped: Calculates the best nesting strategy from two corners: the Nesting corner and the corner that is 
perpendicular to the Nesting direction and opposite the Nesting corner. The result uses the corner that 
yields the best outcome.
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 l Inverted: Calculates the best nesting strategy from two corners: the Nesting corner and the corner that is 
parallel to the Nesting direction and opposite the Nesting corner. The result uses the corner that yields the 
best outcome.

 l Four: Calculates the nesting strategy using all four corners of the sheet.

Improved Error Handling and File Support
When nesting geometry, all errors and other messages are displayed after completing the operation.  Mastercam 
also supports the loading of multiple default sheets when creating a nested part.

Additionally, your nesting parameter values are remembered for the current Mastercam session. This allows you to 
fine-turn your results as you work.

Toggling the Display of Mesh Facet Edges
You can toggle the display of mesh facet edges in your part file with the new Mesh Facet Edges option located in 
the Appearance group of the View tab. 

Mesh Facet Edges Off Mesh Facet Edges On 

In previous versions of Mastercam, this was an option named Show triangle edges in the Shading page of the 
System Configuration dialog box.
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Automatically Adjust the Opacity of the On-screen Ruler
In Mastercam 2023 the opacity of the on-screen ruler, which displays during functions such as Dynamic Transform 
and Dynamic Plane, adjusts depending on the location of your cursor, making it easier to view your part. Hover the 
cursor off the ruler to display more opacity, or hover the cursor over the ruler to display less opacity. 
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POSTS AND MACHINE ENVIRONMENTS

Listed below are the new post and machines for Mastercam 2022. These can be downloaded from the Mastercam 
Tech Exchange.

New Posts and Machines for Mastercam 2022
The following machine environments and posts are now available for Mastercam 2022. These machines can be 
downloaded from the Mastercam Tech Exchange. 

NOTE
Not all machines and posts are available for download. Contact your local Mastercam Reseller for more 
information about acquiring a machine or post. You can also contact your Reseller for more information 
about the Mastercam 2023 versions.

MP multiaxis posts
The following posts have been released for Mastercam Mill. These are all multiaxis posts that are supplied with 
several different machine definitions to support various machine configurations.

Machine Control Configurations Notes

Okuma 5X Mill

Genos M460V-5AX 

OSP Various None

Genos M560-V 5X TRT-AC

Genos M560-V 5X TRT-BC 

MU-4000V 

MU-5000V

MU-6300V 

Fanuc 5X Mill 

Doosan DVF 5000 

Fanuc 30i 31i 32i Various  

A new Fanuc post has 
been created to include 
all Fanuc derivatives. This 
encompasses Doosan 
and Robodrill machines, 
and can be modified for 
any machines. 

Doosan DVF 6500

Doosan DVF 8000 

Doosan VC 630/5AX

Doosan DNM 200/5AX 

Doosan DNM 350/5AX

Robodrill 

Generic Fanuc 5X Mill 
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Machine Control Configurations Notes

Siemens 5X Mill 

DMG DMU 50 Gen2 

Siemens 840D 

 l Various 

 l Head-head 
AC 

 l Head-head 
BC 

 l Table-table 
AC 

 l Table-table 
BC  

The Siemens post now 
adds the Doosan 
machines to its portfolio. 

Doosan DVF 5000

Doosan DVF 6500 

Doosan DVF 8000 

Doosan VC 630/5AX 

Generic Siemens 5X Mill 

Haas 5X Mill 

Haas UMC-1000 

Haas NGC Table-table 

New generation Haas 5-
axis Mill post, replacing 
the previous UMC-750. 
This post supports:

 l The newer 
generation of the 
Haas control

 l DWO (G254)

 l TCPC (G234)

 l TWP (G268)

 l High speed 
machining modes

 l G10 list (tools and 
work datums)

Haas UMC-1000SS 

Haas UMC-1250 

Haas UMC-1250SS 

Haas UMC-1500-DUO 

Haas UMC-1500-DUO 

Haas UMC-1600-H 

Haas UMC-500 

Haas UMC-500SS 

Haas UMC-750 

Haas UMC-750SS  

Lathe machine environments
The following machine environments have been released for Mastercam Lathe. These let users take advantage of 
Mastercam Mill-Turn’s interface and features (including Simulation) for single-stream machines with no more 
than one rotary axis. These machines require only a Lathe and Mill license to run.

Machine Control Configuration

Doosan

Lynx 2600Y_BMT55x24 Fanuc i series  Single Spindle / Single Turret / Tailstock  

Emco

Emcoturn E45 SMY 
Heidenhain PILOT 
640 

Dual Spindle / Single Turret 
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Machine Control Configuration

Mazak

QT-Compact 300MY 500U_12st Nexus 2 Single Spindle / Single Turret / Tailstock 

CMZ

TD35 Y Z1350_16st BO

  Fanuc 31i-A 
Single Spindle / Single Turret / Tailstock / Steady 
Rest  

TD45 Y Z3200_12st BOT

TD45 Y Z2200_12st BOT

DMG Mori Seiki CTX

CTX gamma 3000_R – Gen 1 Siemens 840D 
Single Spindle / Single Turret / Tailstock / Steady 
Rest  

Okuma LB

LB3000 EX II L x1000C OSP-P300L Single Spindle / Single Turret / Tailstock  

Haas ST 

ST-30 Y_S_BMT65x24_v2 
Haas CNC Dual Spindle / Single Turret 

ST-15_S_Hybrid_v2 

DMG Mori Seiki NL 

NL2500SY 700_12st Fanuc 31i-A Dual Spindle / Single Turret 

Mazak Quick Turn 

Quick Turn 350MSY 1500U_VDI Nexus 2 Dual Spindle / Single Turret 

Hwacheon Hi_TECH series 

230AL YSMC_BMT65X24 

Fanuc 0i-MF Dual Spindle / Single Turret  230BL YSMC_BMT65X24 

230CL YSMC_BMT65X24 

DMG Mori Seiki NLX 

NLX3000MC 3000TSY_R_12st BOT 

Mitsubishi (CELOS)   

Single Spindle / Single Turret / Tailstock / Steady 
Rest 

NLX1500MC 500SY_12st BOT  Dual Spindle / Single Turret 

NLX2000MC 500SY_12st BOT – 
Gen 2

Single Spindle / Single Turret / Tailstock / Steady 
Rest 

NLX2000MC 1250TSY_R_12st BOT Dual Spindle / Single Turret 

NLX1500MC 500SY_20st BOT  Dual Spindle / Single Turret 
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Mill-Turn machine environments
The following machine environments have been released for Mastercam Mill-Turn. These machines require a full 
Mill-Turn license.

Machine Control Configurations

Emco Hyperturn

Emco HT 665MC-Plus TCMY Siemens 840D-SL Dual Spindle / Dual Turret  

Victor

Victor Vturn-X200 Fanuc 31i-A5 Dual Spindle / Tool Spindle / Lower Turret

Citizen Miyano

ABX-64SYY2_v2 Fanuc 31i-B Dual Spindle / Dual Turret 

Eurotech

Rapido B436-Y2 Mitsubishi M700 Dual Spindle / Dual Turret 

Takisawa TMX

TMX-2000S
Fanuc 31i-B5

Dual Spindle / Tool Spindle 

TMX-4000ST Dual Spindle / Tool Spindle / Lower Turret 

Mazak Integrex j-series

j-200 500U 

Smooth G 

Single Spindle / Tool Spindle / Tailstock 

J-200S Dual Spindle / Tool Spindle 

j-300 Single Spindle / Tool Spindle / Tailstock 

j-400 Single Spindle / Tool Spindle / Tailstock 

DMG Mori Seiki CTX 

CTX beta 1250 TC 4A – Gen 2

Siemens 840D (DMG 
Structure) 

Dual Spindle / Tool spindle / Lower Turret 

CTX gamma 3000 – Gen 1 Single Spindle / Single Turret / Tailstock 

CTX gamma 1250 TC 4A – Gen 2 Dual Spindle / Tool Spindle / Lower Turret 

CTX gamma 2000 TC 4A – Gen 2 Dual Spindle / Tool Spindle / Lower Turret 

CLX 450 TC_S Dual Spindle / Tool Spindle 

DMG Mori Seiki NTX

NTX1000 SZM – Gen 2 
Siemens 840D (DMG 
Structure) 

Dual Spindle / Tool Spindle / Lower Turret  NTX2500 1500SZM – Gen 2_
BMT60x10 

Nakamura-Tome 

Super NTJX Fanuc 31i-A5 Dual Spindle / Tool Spindle / Lower Turret 
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Machine Control Configurations

NTY3-100 Fanuc 31i-B Dual Spindle / Triple Turret 

Okuma LU 

LU4000 EX-MY 2SC x2000  
OSP-P300L 

Single Spindle / Dual Turret / Tailstock 

LU35-II 2SC x1500   Single Spindle / Dual Turret / Tailstock 

Okuma Multus U 

U4000 2SW x1500_Compact-H1  

OSP-P300 

Dual Spindle / Tool Spindle / Lower Turret 

U4000 2SW x2000_Compact-H1 Dual Spindle / Tool Spindle / Lower Turret 

U4000 1SW x1500_Compact-H1 Dual Spindle / Tool Spindle 

U5000 1SW x3000 Dual Spindle / Tool Spindle 

Mazak Integrex e-series 

E-500 H-II 4000U_R 

Matrix 2 

Single Spindle / Tool Spindle / Tailstock / 
Steady Rest 

E-650 H-II 4000U_R 
Single Spindle / Tool Spindle / Tailstock / 
Steady Rest 

E-500 H-SII 3000U_R Dual Spindle / Tool Spindle / Steady Rest 

E-650 H-SII 3000U_R Dual Spindle / Tool Spindle / Steady Rest 

Mazak Integrex i-series 

i-200HST 850U 

SmoothAI 

Dual Spindle / Tool Spindle / Lower Turret 

i-250HST 1500U Dual Spindle / Tool Spindle / Lower Turret 

i-250HS Dual Spindle / Tool Spindle 

i-200HS 850U Dual Spindle / Tool Spindle 

What's New in Mastercam 2023—Posts and Machine Environments



Attention! Updates may be available. 
Please refer to my.mastercam.com/product-

downloads for the latest downloads.
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